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About This Document

Reference Documents
This reference guide refers to the following documents:

Conventions
Keystrokes are indicated as follows:

Typeface conventions used include:

Part Number Document Title

A61406-001 Late Breaking News
A61411-001 Intel® PRO/Wireless 2011B LAN Access Point Quick Installation Guide
A61428-001 Intel® PRO/Wireless 2011B LAN Adapter Product Reference Guide
A61429-001 Intel® PRO/Wireless 2011B LAN Access Point Product Reference Guide
A61437-001 Intel® PRO/Wireless 2011B LAN Power Injector Quick Reference Guide
A63056-001 Intel® PRO/Wireless 2011B LAN Adapter Quick Installation Guide

ENTER identifies a key.

FUNC, CTRL, C identifies a key sequence. Press and release each key in turn.

Press A+B press the indicated keys simultaneously.

Hold A+B press and hold the indicated keys while performing or waiting for another 
function. Used in combination with another keystroke.

<angles> indicates mandatory parameters in syntax.

[brackets] for command line, indicates available parameters; in configuration files, brackets 
act as separators for options.

GUI Screen text indicates the name of a control in a GUI-based application.

Italics indicates the first use of a term, book title, variable or menu title.

Bold indicates important user information, license provisions or warranty conditions.

Screen dialog indicates screen dialog and user input options, and the exact syntax of items.

Screen text indicates text and data displayed in an application screen on a computer monitor.

Terminal textTerminal textTerminal textTerminal text indicates text shown in a radio terminal LCD screen.

URL indicates a Uniform Resource Locator, such as a Web page address.
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About This Document
This document uses the following for certain conditions or types of information:

indicates tips or special requirements.

indicates conditions that can cause equipment damage or data loss.

indicates a potentially dangerous condition or procedure that only Intel® PRO/Wireless 2011B 

LAN-trained personnel should attempt to correct or perform.
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Chapter 1. Site Survey Overview

A site survey is an in-depth examination and analysis of a proposed wireless LAN site. The purpose 
of a site survey is to determine the number of access points, the types of antennas needed, and the 
best placement for those access points and antennas. 

Although the goal of a site survey is simple, the means of arriving at that goal are not. Some of the 
steps involve taking measurements, but most of a site survey involves experience, trial and error, 
and a little guesswork rather than numbers and figures.

The Intel® PRO/Wireless 2011B LAN Access Point ships with a standard omnidirectional “rubber 
duck” direct sequence (DS) dual dipole antenna assembly. If you plan to deploy any other antenna 
type at any location at the site, be sure to use that antenna type at that location during the survey. 
Survey results based on one antenna type are not valid for any other antenna type.

Contact an Intel® PRO/Wireless 2011B LAN sales representative for available antenna options.

For more information, refer to the Intel® PRO/Wireless 2011B LAN Solutions web site
 (http://www.intel.com/network/products/wireless.htm).

1.1 When to Perform a Site Survey

Intel recommends that you perform a site survey prior to installing a wireless LAN. Site surveys are 
especially important:

• Before installing a new site.

Evaluate the placement of the access points and antennas throughout the proposed site. 

• Before changing an existing site.

When modifying or extending an existing network structure, re-evaluate the placement of the 
access points and antennas. If you need a different level of coverage in some areas, you may 
need to move, replace, or supplement access points and antennas.

• After physical changes to the site.

Remodeling may introduce new sources of interference, such as motors and metal structures 
within the coverage area of the access point, even when it does not directly affect the sites 
where the access points are located.

1.2 Elements of an Effective Site Survey

There are four important elements of an effective site survey:

• Examine the network usage problems the wireless LAN solves. 

How many clients need a wireless LAN connection? What areas of the site require wireless 
LAN connectivity? How many hours each day is wireless LAN connectivity required? Which 
locations are likely to generate the largest amount of data traffic? Where is future network 
expansion most likely?

• Study blueprints of the proposed wireless LAN site.

A site blueprint provides a map of the site as well as the location of objects such as walls, 
partitions, and anything else that could affect the performance of a wireless LAN. Examining 
the site blueprint prior to conducting the physical walk-through helps you identify areas where 
wireless equipment is likely to perform well and areas where it is not. Many obstructions are 
not readily visible and, in some cases, a room originally built for a specific purpose, such as a 
radiology lab, might have been converted into something completely different, such as a 
conference room. The blueprint may also show areas proposed for future building expansion.
Intel® PRO/Wireless 2011B LAN Site Survey Administrators Guide 1
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Chapter 1. Site Survey Overview
To prepare for the next step of the site survey, mark possible wireless device locations on the 
blueprint and refer to the marked blueprint during the physical walk-through and inventory.

• Conduct a physical walk-through and inventory. 

The primary purpose of the physical walk-through is to document any items or materials near a 
proposed device location that may interfere with reception or transmission and affect network 
performance. Document stock and inventory levels,  current environmental conditions and any 
materials that may interfere with wireless LAN transmissions. A list of some of these materials 
is included in 1.4 Equipment and Materials on page 3.

• Measure the radio frequency (RF) transmissions.

Intel® PRO/Wireless 2011B LAN Site Survey provides the means to measure the signal 
strength, the transmission rate and the number of successfully transmitted packets. This step in 
the site survey involves mounting access points and antennas in the proposed locations and 
measuring the RF signal strength, transmission rate and packet throughput.

An effective site survey requires all of these elements. Failure to commit the appropriate time, 
money, and energy to accomplish a proper site survey in advance may result in greater expenditures 
of money and time later, when problems arise that require repeated adjustments to the wireless 
configuration.

1.3 Environmental Concerns

Physical and environmental conditions affect the performance of wireless LAN equipment. 
Wireless LAN sites should not be excessively hot, cold, humid, or dusty. The area should also be 
relatively free of electronic equipment that generates background RF noise, which can interfere 
with wireless LANs.
2 Intel® PRO/Wireless 2011B LAN Site Survey Administrators Guide



Chapter 1. Site Survey Overview
1.4 Equipment and Materials

Some of the equipment and materials that can interfere with wireless LAN transmissions include:

• Equipment that produces radio waves in the 2.4 GHz range.

• Existing wireless LANs.

• Cordless telephones or cordless telephone stations. (Cellular telephones are OK.)

• Microwave ovens closer than three meters (ten feet) from the antenna.

• Radio frequency identification tags.

• Ceiling-mounted sprinkler heads  closer than 60 centimeters (two feet) from the antenna.

• Outside broadcast television used by mobile television cameras.

• Uninterruptable power supply (UPS) devices.

• Pine trees with needles near wavelength or half wavelength.

• Large heat-producing machines or chambers.

• Fluorescent lights.

• Overhead cranes.

• Overhead conveyors.

• Elevator shafts.

• Heavy-duty motors.

• Lead paint.

• Plants and trees.

• Power surge protectors.

• Refrigerators.

• Sulfur plasma lighting.

• Transformers.

Relative Attenuation of RF Obstacles

Obstruction
Degree of 

Attenuation Example

Open Space None Cafeteria, courtyard

Wood Low Inner wall, office partition, door, floor

Plaster Low Inner wall (old plaster lower than new plaster)

Synthetic Materials Low Office partition

Cinder block Low Inner wall, outer wall

Asbestos Low Ceiling

Glass Low Non-tinted window

Wire Mesh in Glass Medium Door, partition

Metal Tinted Glass Medium Tinted window

Human Body Medium Large group of people

Water Medium Damp wood, aquarium, organic inventory

Bricks Medium Inner wall, outer wall, floor

Marble Medium Inner wall, outer wall, floor
Intel® PRO/Wireless 2011B LAN Site Survey Administrators Guide 3



Chapter 1. Site Survey Overview
1.5 Electrical Concerns

It is important that the right kind of power supply be available for access points. The following are 
electrical installation alternatives listed in order of most to least desirable.

• Dedicated circuit with a UPS that also acts as a filter and surge suppressor.

• Non-dedicated circuit with a UPS.

• Non-dedicated circuit with a surge suppressor.

Configurations without a UPS are not recommended. A dedicated circuit is preferable to a non-
dedicated circuit. Non-dedicated circuits have open receptacles; the load and type of use cannot be 
predicted at the time of installation. Although the current draw of the access points is minimal, 
other devices on the circuit can affect the access points.

If it is absolutely necessary to have a non-dedicated circuit, Intel recommends that the circuit not 
support the following:

• Non-network devices, such as lighting, powered directly from the circuit.

• Devices with components that produce heat such as space heaters, laser printers, heat guns, 
soldering irons, or photocopiers.

• Devices that often cause sudden sharp surges in the power line ~ contain medium or large 
motors, such as electric staplers, refrigerators, floor cleaning equipment, air conditioners, fans, 
or any single device drawing more than 20% of the rated value the circuit.

• Any combination of devices drawing more than 60% of the rated value of the circuit.

In all cases, the power to the access points must be unswitched and available 24 hours per day. Intel 
recommends that the power never be provided from an energy management system. 

You can simplify power distribution to Intel® PRO/Wireless 2011B LAN Access Points by using 
the Intel® PRO/Wireless 2011B LAN Power Injector, which is described in 2.2.5 Supplying Power 
by Power Injector on page 13.

Ceramic (Metal Content 
or Backing)

High Ceramic tile, ceiling, floor

Paper High Roll or stack of paper stock

Concrete High Floor, outer wall, support pillar

Bulletproof Glass High Security booth

Silvering Very High Mirror

Metal Very High Desk, office partition, reinforced concrete, elevator 
shaft, filing cabinet, sprinkler system, ventilator

Relative Attenuation of RF Obstacles

Obstruction
Degree of 

Attenuation Example
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Chapter 1. Site Survey Overview
1.6 Size and Shape of the Site

The size of the site determines what equipment you need and where to place it.

• A small site requires fewer than 10 access points; two are usually sufficient.

• A medium-sized site requires between 10 and 20 access points.

• A large site requires 20 to 100 access points and possibly some directional antennas.

See Chapter 4. Conducting a Site Survey on page 41 for more information.

The shape of the site is also a concern. RF transmissions propagate differently in a narrow space, 
such as a hallway, than in a large open area, such as an office filled with cubicles. Open doorways 
might also affect RF propagation.

Contact an Intel® PRO/Wireless 2011B LAN sales representative for available antenna options.

For more information, refer to the Intel® PRO/Wireless 2011B LAN Solutions web site
 (http://www.intel.com/network/products/wireless.htm).

1.7 Network Usage Requirements

When designing a site, consider all of the probable uses for the wireless network. Important factors 
include mobility, performance, security, redundancy, and system interface requirements.

1.7.1 Mobility Requirements

Determine whether the customers are in motion continually, such as in a warehouse or hospital, or 
whether the customers work from different fixed locations throughout the site.

1.7.2 Performance Requirements

Consider whether the people using wireless devices need higher data rates for time-bounded 
transmissions, such as audio and video, or whether the system most often handles burst or typical 
knowledge worker data traffic. If computers require higher data rates, put access points closer 
together, because the higher transmission rates can only be obtained near the access points.

The number of computers per access point varies with the customer applications and other system 
factors. Typically, an access point readily accommodates 10 to 30 computers. Areas with a high 
density of computers, such as conference rooms, may require additional access points.

In addition, the performance of the wireless LAN depends on whether it is located indoors or 
outdoors. Some performance specifications for indoor and outdoor wireless LANs include:

• In an indoor environment, wireless devices typically can transmit about 18 meters (60 feet) at 
11 Mbps. Some data packets may be transmitted at 5.5 Mbps at this distance when LAN traffic 
is heavy.

• In an indoor environment, wireless devices typically can transmit about 30 to 36 meters (100 to 
120 feet) at 5.5 Mbps. Some data packets may be transmitted at 2 Mbps at this distance when 
LAN traffic is heavy.

• In an outdoor environment, wireless devices typically can transmit about 180 to 365 meters 
(600 to 1200 feet) at varying speeds.
Intel® PRO/Wireless 2011B LAN Site Survey Administrators Guide 5
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Chapter 1. Site Survey Overview
1.7.3 Security Requirements

Because wireless LANs use unsecured radio waves to transmit data, security is an important 
consideration for network administrators designing wireless networks. Network administrators 
should consider whether encryption such as Wired Equivalent Privacy (WEP) is necessary to 
protect sensitive data transmitted over wireless networks or if the customer can afford a lower 
degree of security.

1.7.4 Redundancy Requirements

Intel recommends that you design your wireless system so that each access point has redundancy 
from another access point. This provides not only for redundancy, but increased overall system 
performance. Typically, you need only increase the access point count by about 20% to ensure that 
all coverage locations have 11 Mbps primary coverage and 5.5 Mbps secondary coverage.

1.7.5 System Interface Requirements

Consider the degree to which the wireless LAN (WLAN) will interact with the conventional wired 
LAN. Some legacy systems, such as older mainframe networks, may not support WLANs without 
additional hardware or software. Token Ring networks, for example, are not compatible with IEEE 
802.1l WLANs without some sort of gateway or interface.

Roaming from one access point located on one IP subnet to an access point located on another IP 
subnet causes loss of IP connectivity, unless special considerations are made. Mobile IP, which is 
available in all Intel® PRO/Wireless 2011B LAN devices, enables the access points to become 
home and foreign logical devices to a roaming workstation. Mobile IP is well suited to a smaller 
number of users and access points. For larger WLANs, it may be better to implement a virtual LAN 
(VLAN) and maintain all the access points on one subnet  or consider third party Mobile IP 
solutions.

1.8 Channel Selection Considerations

Of the 11 to 14 available channels, the exact number dependent on local regulation, only channels 
1, 6 and 11 are “clear” channels in the United States. To avoid inter-channel interference between 
access points, configure your access points to these three clear channels or their equivalents in other 
countries. Arrange your access points in such a way as to avoid having same channel units adjacent 
to one another.

You cannot adhere to this recommendation in some situations, such as in a building with several 
access points on multiple, adjacent floors, where the access points transmit through many floor 
structures. Adjacent access points operate properly when they use the same channels. Each access 
point “hears” the other, and takes its turn transmitting. This situation may cause a reduction in data 
throughput if it occurs in a very active area, so design your channel layout accordingly.

1.9 Recommended Procedure for Performing a Site Survey

Using the Intel® PRO/Wireless 2011B LAN Site Survey utility to perform a site survey involves 
selecting possible locations for the access points from a review of the floor plan layout, based on 
estimated of the range of an access point within the site. Range estimates are based on previous 
experience, physical test and measurement or calculation from the rated hardware specifications.
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Proposed locations are validated by temporarily installing one access point and using the Site 
Survey utility to test the actual range and coverage area of that access point in that location. Adjust 
the position of the access point as required until you validate the coverage area.

After you validate the first proposed access point position, annotate it on the floor plan layout, 
move the access point to the next adjacent location, and test the access point coverage from that 
location. Repeat this procedure of testing, adjusting positions, and relocating the access point until 
the entire proposed coverage area and all of the proposed locations have been validated.

Intel recommends that you accomplish the site survey using the continuous Internet Control 
Message Protocol (ICMP) “ping” test with a block size of 1024 bytes.

1.9.1 Helpful Hints and Tips

• Floor to floor interaction between access points is usually not a problem, unless the floor is 
wood. If interaction can occur, ensure that the channel selections are appropriate for vertically 
adjacent access points. Floor to floor interaction can be a good thing, as it provides for 
redundancy.

• Close all office and room doors before beginning the survey. This puts more material between 
the transmitter and receiver, allowing you to assess reception at its lowest everyday level.

• Conference rooms may have a high density of computers, so ensure adequate access points for 
satisfactory throughput. Consider redundancy for these areas.

• In high security areas where access may be limited, such as boardrooms and labs, consider 
placing access points adjacent or straddling the area, rather than directly in the area. When 
maintenance is required on the access points, access to the restricted area is not required.

• Cafeteria areas can be a high usage and demand area, as  informal employee meetings are often 
conducted there.

• Computer to access point ratios are typically maintained at a maximum of approximately 20-
to-1, depending on the type of applications and data.

• Areas with multiple conference rooms in close proximity are often given additional access 
points to provide 11 Mbps redundancy and ensure adequate throughput.

• The optional Sandra “D” omnidirectional antenna provides good performance and a low 
profile with good cosmetics, which makes it the best choice for the typical office environment.

• The optional high performance dipole antenna provides the best overall performance, without 
regard for size or appearance, which makes it the best choice for areas where aesthetics are 
unimportant, such as computer and telecommunication rooms.

Contact an Intel® PRO/Wireless 2011B LAN sales representative for available antenna options.

For more information, refer to the Intel® PRO/Wireless 2011B LAN Solutions web site
 (http://www.intel.com/network/products/wireless.htm).
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Chapter 2. Preparing for an Intel® Wireless LAN Site Survey
Chapter 2. Preparing for an Intel® Wireless LAN Site Survey

Installing an Intel® PRO/Wireless 2011B LAN begins with conducting a site survey. A site survey 
involves using the Site Survey utility to determine the physical requirements for a site-specific 
Intel® PRO/Wireless 2011B LAN. A site survey analyzes the installation environment and 
provides recommendations for equipment and placement.

Use the Site Survey utility to determine the placement of access points and antennas, as well as the 
number of devices necessary to provide optimal service. The facility can be a warehouse, 
manufacturing plant, office building or retail store.

In the installation of an Intel® PRO/Wireless 2011B LAN, complete radio coverage could require 
optional antennas.

Contact an Intel® PRO/Wireless 2011B LAN sales representative for available antenna options.

For more information, refer to the Intel® PRO/Wireless 2011B LAN Solutions web site
 (http://www.intel.com/network/products/wireless.htm).

If you are unfamiliar with the Intel® PRO/Wireless 2011B LAN infrastructure and the components 
that comprise it, refer to the Intel® PRO/Wireless 2011B LAN Access Point Product Reference 
Guide.

2.1 Inspecting the Survey Area

During the planning stages of the site survey, a representative from the Intel site survey team visits 
the proposed radio coverage site. As a standard practice in the site survey consultation, the Intel 
representative gathers facility drawings and completes a Site Survey Requirements document and a 
site survey questionnaire. The representative documents the wiring used within the facility 
(Category 5 for 10 Mbps Ethernet or 10/100 switched Ethernet, fiber optic cabling, etc.) and 
assesses its applicability to Intel® PRO/Wireless 2011B LAN components.

Select several trial installation areas. The site survey team analyzes each proposed installation area 
to document radio transmission constraints and to develop preliminary access point placement 
alternatives to be tested during the actual site survey. Document the findings from the initial site 
inspection in a Site Survey Request Form and use that form as the outline of the site survey.

Considered the following variables in the site survey requirements definition:

• RF systems already in use.

• Availability of lifts for mounting access points.

• Location of host system(s).

• Available AC power.

• Interfering metal fire breaks and wall structures.

• Availability of customer technical personnel to answer questions during the survey.

• Doorways and passages affecting RF propagation.

The completion of the RF Site Survey Requirements document is a coordinated effort between the 
site survey team and the customer management team.

The RF Site Survey Requirements document does not identify potential installation constraints 
within the customer site, nor does it recommend access point and antenna placement location. The 
RF Site Survey Requirements document represents a preliminary overview of the customer site 
used as a baseline for refining site survey requirements.
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2.1.1 Assessing Environmental Radio Coverage

The site survey team selects trial component installation areas away from transformers, heavy-duty 
motors, fluorescent lights, microwave ovens, refrigerators and other industrial equipment. Areas 
with excessive moisture, heat and dust are inappropriate for staging a wireless network.

Signal loss can occur when metal, concrete, walls or floors block access point transmission areas. 
Access point antennas are trial-mounted in open areas or added to an existing access point to boost 
the Intel® PRO/Wireless 2011B LAN coverage area.

The positioning of an access point depends on the floor plan of the site. The site survey team makes 
access point and antenna placement recommendations based on the following installation site 
variables:

• Outdoor or indoor installation site.

• Large or small proposed radio coverage area.

• Wide or narrow proposed coverage area.

• Number of additional devices operating in the proposed coverage area.

• Open coverage area or area with documented obstructions.

General Guidelines

Site surveys for direct sequence spread spectrum devices require experimentation with different 
antennas at various angles. Placing a directional antenna in a vertical position can often minimize 
multi-path problems.

In an indoor environment the range at 11 Mbps is about 18 meters (60 feet), with some data packets 
transmitting at 5.5 Mbps. The range at 5.5 Mbps is between 30 and 36 meters (100 and 120 feet), 
with some data packets transmitting at 2 Mbps. In an open air environment, the range is between 
182 and 365 meters (600 and 1200) feet. These measurements were obtained with antenna diversity 
enabled.

Do not locate access points near corners, against walls, against metal walls or inside metal conduits.

2.1.2 Preventing Channel Interference

Intel® PRO/Wireless 2011B LAN access points require careful survey area testing to ensure radio 
transmissions do not overlap. If necessary, adjacent access points require omnidirectional and 
directional antennas to optimize radio coverage in conflicting coverage areas and neighboring cells 
with the same direct sequence channel.

Intel® PRO/Wireless 2011B LAN access points supporting different coverage areas in close 
proximity to one another should be configured using direct sequence channels as far apart as 
possible, such as channels 1, 6, and 11.
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2.2 Placing Antennas

The role of a wireless antenna is to direct radio frequency (RF) power from a radio into the 
coverage area. The coverage area is also called a cell. Access point antenna coverage resembles 
lighting in that an area lit from far away might not be bright enough. Even access point placement 
(like even placement of light bulbs) provides even, efficient coverage.

There are two types of antennas: omnidirectional and directional antennas. Different antennas 
produce different coverage patterns and need to be selected and placed according to site coverage 
requirements.

The Intel® PRO/Wireless 2011B LAN Access Point ships with a standard omnidirectional “rubber 
duck” direct sequence (DS) dual dipole antenna assembly.

The Intel® PRO/Wireless 2011B LAN Access Point  dual antenna assembly provides diversity that 
can improve performance and signal reception. Intel continues to add antenna options for Intel® 
PRO/Wireless 2011B LAN devices.

Contact an Intel® PRO/Wireless 2011B LAN sales representative for available antenna options.

For more information, refer to the Intel® PRO/Wireless 2011B LAN Solutions web site
 (http://www.intel.com/network/products/wireless.htm).

2.2.1 Placing an Omnidirectional Antenna

Intel recommends omnidirectional antennas in areas where the coverage area is in an open area 
with little interference. An omnidirectional antenna transmits and receives radio waves in a 360° 
coverage pattern on a horizontal plane. The coverage area is circular with the antenna at the center. 
The coverage pattern is torus-shaped (doughnut-shaped), making them ideal for square or fairly 
square areas.

Intel’s omnidirectional antennas include:

• Intel® PRO/Wireless 2011B LAN Access Point standard “rubber duck” direct sequence (DS) 
dual dipole 1dB-gain indoor/outdoor antenna.

• Ceiling mount dipole HPA1 3dB-gain or HPA2 0dB-gain indoor/outdoor antenna.

• Sandra “D” low profile 1.8dB-gain indoor antenna.

• Flat plane Velcro† mount 0dB-gain indoor antenna.

With an omnidirectional antenna, the radio range of the access point could have a radius up to 300 
meters (1000 feet) in open areas. In office or retail environments, obstructions can reduce the 
coverage to a radius of 55 to 75 meters (180 to 250 feet).
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2.2.2 Placing a Directional Antenna

Intel recommends directional antennas where the coverage area is confined to an area such as a 
hallway or corridor. Use a directional antenna for sites that require longer distances over relatively 
narrow areas.

Directional antennas transmit and receive radio waves off the front of the antenna. The power 
behind and to the sides of the antenna is reduced. The coverage area is oval, with the antenna at one 
of the narrow ends. The antenna direction is specified by the angle of the coverage pattern, called 
the beam width. Typical directional antenna beam widths range are from a somewhat directional 
90° angle to a very directional 20° angle.

A directional antenna directs power to concentrate the coverage pattern in a particular direction. For 
directional antennas, signal strength or gain can be increased by diverting power from the non-
coverage areas and redirecting it into the area where coverage is required.

Intel’s directional antennas include:

• Patch 70° wide beam 4dB-gain indoor/outdoor antenna.

• Panel 22° narrow beam 5dB-gain indoor/outdoor antenna.

• Yagi 30°  narrow beam 9dB-gain indoor/outdoor antenna.

2.2.3 Calculating Antenna Site Coverage

When directional antenna power is concentrated, RF coverage increases within the beam width. 
The increase in RF coverage within the beam width is called antenna gain and is measured in 
decibels (dB), the unit of comparative power for assessing radio signal strength.

Increasing the antenna gain improves the range of the signal for better communication. Each 1 dB 
increase in antenna gain results in a range increase of about 2½% for indoor sites and about 5% for 
unobstructed outdoor sites.

Actual results vary depending on the number and type of  obstructions.

2.2.4 Supplying Power from Site Electric Circuits

Intel® PRO/Wireless 2011B LAN access points draw power from wall outlets. Access point 
performance is subject to degradation due to inherent or random electrical problems or site-specific 
disturbances.

Access point electrical installation alternatives are listed below in order from optimal to preferred 
for an installation area:

1. Isolated ground circuit with an online, uninterruptable power supply (UPS) that also acts as a 
filter and surge suppressor.

2. Isolated ground circuit with a surge suppressor.

3. Dedicated circuit with a UPS.

4. Dedicated circuit with a surge suppressor.

5. Nondedicated circuit with a UPS.

6. Nondedicated circuit with a surge suppressor.
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When using a Network Controller Unit, Intel recommends items one through four only. The use of 

nondedicated circuits for configurations five and six could cause data loss and serious transmission 

problems. By its nature, a nondedicated circuit contains open receptacles. The load and type of use 

of open receptacles in a nondedicated circuit cannot be predicted after installation.

If you must use a nondedicated circuit, Intel recommends that the circuit not support any of the 
following:

• Hard wired devices.

• Devices with components intended or known to produce heat such as space heaters, laser 
printers, heat guns and soldering irons.

• Single device drawing more than 20% of the rated value of the circuit.

• Devices drawing more than 60% of the rated circuit value.

Ensure that each access point has power available 24 hours per day. Intel recommends access point 
power never be provided from an Energy Management System.

2.2.5 Supplying Power by Power Injector

The Intel® PRO/Wireless 2011B LAN Power Injector supplies power to the Intel® PRO/Wireless 
2011B LAN Access Point using the standard Ethernet data cable that connects to the Access Point.

 Typically, an Intel® PRO/Wireless 2011B LAN Access Point is connected to a LAN through a 
standard Ethernet cable. The Access Point also requires DC power, which is supplied by standard 
AC power line and AC-to-DC converter.

The Intel® PRO/Wireless 2011B LAN Power Injector eliminates the need to install AC wiring to 
the Access Point and lets you consolidate power management and control in the wiring closet. 
Rather than plugging the AC power supply directly into the Access Point, the AC power supply 
connects to the Power Injector. Low-voltage DC power to the Access Point is carried over the 
unused wires in a standard four-pair Category 5 (Cat-5) cable with RJ-45 connectors.

The maximum total cable length between the hub and the Access Point is 100 meters (328 feet).

Intel® PRO/Wireless 2011B LAN Power Injector Specifications

The Intel® PRO/Wireless 2011B LAN Power Injector is suitable for international use. The power 
supply operates using 100, 120 and 220 VAC power sources.

• Power supply input: 85 VAC to 270 VAC.

• Power supply output: 24 VDC.

• Dimensions: 8.25 cm (3.25”) long × 5.72 cm (2.25”) wide × 3.8 cm (1.5”) high.

• Temperature: 0°C (32°F) to 40°C (104°F).

• Storage: –40°C (–40°F) to 60°C (140°F).

• Humidity: 5% to 95% (non-condensing).
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For more information, refer to the Intel® PRO/Wireless 2011B LAN Solutions web site
 (http://www.intel.com/network/products/wireless.htm).

For installation instructions, refer to the Intel® PRO/Wireless 2011B LAN Power Injector Quick 
Reference Guide.
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Chapter 3. Using the Site Survey Utility

Use the Intel® PRO/Wireless 2011B LAN Site Survey utility to establish a two-way data network 
using both stationary and mobile devices at various points within the proposed radio coverage area.

To determine areas requiring additional or higher performance antennas, assess access point signal 
strength using various antenna and access point configurations

Contact an Intel® PRO/Wireless 2011B LAN sales representative for available antenna options.

For more information, refer to the Intel® PRO/Wireless 2011B LAN Solutions web site
 (http://www.intel.com/network/products/wireless.htm).

The Intel® PRO/Wireless 2011B LAN Site Survey utility runs under Microsoft Windows† 95, 98, 
ME, NT, and 2000.

1a
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3.1 Installing the Intel® PRO/Wireless 2011B LAN Site Survey Utility

To perform an Intel® PRO/Wireless 2011B LAN site survey, the Site Survey utility must first be 
installed in the Intel® PRO/Wireless 2011B LAN mobile computer, also known as a mobile unit or 
MU, to be used in the site survey.

3.1.1 Installing the Site Survey Utility from a CD-ROM

To install the Intel® PRO/Wireless 2011B LAN Site Survey utility from a CD-ROM:

1. Insert the installation CD-ROM in the computer CD drive.

2. On the Intel® PRO/Wireless 2011B LAN splash screen, click Install Software.

3. When the installation wizard asks whether or not to install the Access Point Administration 
Tools, click Yes.

The installation wizard installs the Site Survey utility along with the other Intel® PRO/
Wireless 2011B LAN software tools.

3.1.2 Starting the Site Survey Utility

Under Microsoft Windows 95

• Click Start > Programs > Intel® Wireless LAN >  Site Survey.

Under Microsoft Windows 98, ME, NT or 2000

• Click Start > Programs > Intel® Wireless LAN > Access Point Administration Utilities > 
Site Survey or double-click the Site Survey icon on the Microsoft Windows† desktop.
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3.2 Creating a Trial Intel® PRO/Wireless 2011B LAN

Before using the Site Survey utility to test component radio signal strength, you must create an 
Intel® PRO/Wireless 2011B LAN infrastructure. To create an Intel® PRO/Wireless 2011B LAN 
and perform a site survey, you need the following equipment in addition to the Site Survey utility:

• Access points.

• Digital camera.

• Distance measurement wheel.

• Directional and omnidirectional antennas.

• Computers with extra batteries.

• Access point battery or Intel® PRO/Wireless 2011B LAN Power Injector.

• AC power extension cords or Intel® PRO/Wireless 2011B LAN Power Injector.

Contact an Intel® PRO/Wireless 2011B LAN sales representative for available antenna options.

For more information, refer to the Intel® PRO/Wireless 2011B LAN Solutions web site
 (http://www.intel.com/network/products/wireless.htm).

3.2.1 Installing a Trial Intel® PRO/Wireless 2011B LAN

1. Connect the access point antenna(s).

2. Mount the access points.

Mount access points at the locations recommended on the floor plan drawing. Start with the 
most difficult coverage area first. Position the access points so the antennas are not obstructed.

3. Power on the access points.

In the absence of an AC wall socket, use battery power.

4. Observe access point LED behavior.

Observe the LEDs to verify normal boot operation. After the boot cycle ends, the StatusStatusStatusStatus LED 
flashes approximately once every second to indicate proper access point operation.

Component installations differ depending on the device installed. Refer to the documentation 
shipped with each component to ensure proper installation and configuration.

5. Power on the computers used for the site survey.

The Site Survey utility should already be loaded on the mobile devices and desktop computer used 
to perform the survey.

When powered on, the device  displays a boot server connection failure message. This is 
normal, because the access point is not yet connected to an Ethernet network.

6. Set the access point and computer Network Name (SSID).

7. Set the computer(s) and access point to the same Network Name. Normally, the access point 
default value 101 is used.

After you set the Network Names, you can begin testing the Intel® PRO/Wireless 2011B LAN for 
radio transmission effectiveness with the Site Survey utility.
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3.3 Using the Intel® PRO/Wireless 2011B LAN Site Survey Utility

To start the Intel® PRO/Wireless 2011B LAN Site Survey utility:

Under Microsoft Windows 95

• Click Start > Programs > Intel® Wireless LAN >  Site Survey.

Under Microsoft Windows 98, ME, NT or 2000

• Click Start > Programs > Intel® Wireless LAN > Access Point Administration Utilities > 
Site Survey or double-click the Site Survey icon on the Microsoft Windows† desktop.

The Site Survey utility Welcome dialog box opens.

Use the Welcome dialog box to:

• Open an existing site survey area workspace.

• Create a new workspace.

• Create a new workspace from an existing site survey area workspace (.ssw) or site survey 
template (.sst) file.

• Open a recently used workspace.

A workspace corresponds to the entire survey site area, which is distinct from the various and 
individually named radio coverage areas within a survey site.  Create a separate workspace for 
every survey conducted at the same site.

If you open an existing site survey workspace that contains one or more survey areas, the Site 
Survey Test dialog box opens.

Use the Site Survey Test dialog box to specify the Internet Control Message Protocol (ICMP) test 
parameters for the survey area.

If you open an existing survey workspace that does not have a survey area defined, the Site Survey 
dialog box opens.

Use the Site Survey dialog box to:

• Enter the site survey area name.

• Enter the surveyor.

• Enter a description.
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3.3.1 Creating a New Site Survey

To open a Site Survey dialog box, select New Site Survey from the File menu.

3.3.2 Selecting an Existing Site Survey

To open a standard Microsoft Windows† dialog box displaying site survey workspace (.ssw) files, 
select Open Site Survey from the File menu.

If an invalid file is read, an error message displays. Otherwise, a bar graph displays the progress as 
the workspace is loaded.

If the workspace has at least one defined area, the Site Survey Test dialog box opens.

If the existing workspace does not have a defined area, the Site Survey Area dialog box opens.

The status bar displays the workspace and area name.

3.3.3 Defining a New Site Survey Area

To display a Site Survey Area dialog box, select New Area from the File menu.

Use the Site Survey Area dialog box to:

• Enter the area name.

• Enter a description.

An error message displays if you leave the Area Name field blank or enter the name of an existing 
area. The area name displays at the bottom of the screen.
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The Test Name field lists the tests defined for that area. To add a new test, click the ellipsis (…) 
button. For more information on adding new tests, refer to Setting New Test Parameters on page 35.

Delete is disabled when defining a survey area.

3.3.4 Saving a Workspace

To save the open workspace using the existing survey name, select Save from the File menu.

To save the survey using a different name, select Save As from the File menu.

3.3.5 Importing a Site Survey

To display an Import Areas and Tests dialog box, select Import from the File menu.

Use the Import Areas and Tests dialog box to import survey areas or tests from another survey 
workspace.

To replace existing survey areas and tests or to add new ones, select Import Areas or Import Tests 
or both, as appropriate.

To open a standard Microsoft Windows† dialog box displaying site survey workspace (.ssw) files, 
click Import.

3.3.6 Working with Reports

A Site Survey Report can be generated, edited and printed for each site survey workspace. The Site 
Survey Report is a Microsoft WordPad† document generated when the survey is complete.

The report can be edited as a typical WordPad† Rich Text Format (RTF) document. The template 
for a new report has the filename “Site Survey Results.doc” and is installed in the same 
directory as the Site Survey utility program.

3.3.7 Displaying Recent Site Surveys

To display the last four site survey workspace files created or accessed, select Recent Site Surveys 
from the File menu.

Select any workspace in the list to load that workspace.

If a workspace is already open, you are prompted to save the existing workspace first.
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If there is at least one Area defined for the workspace, the Site Survey Test dialog box opens.

The status bar at the bottom of the dialog box displays the status, filename, area name, and 
workspace name.

3.3.8 Editing Existing Site Survey Information

To edit existing site survey information, select Site Survey from the Edit menu.

Use the Site Survey dialog box to enter the site name, surveyor, and description.

If a workspace is already open, you are prompted to save the existing workspace. To save the edited 
workspace information, click OK.

3.3.9 Editing the Properties of an Existing Site Survey Area

To view a list of existing site survey areas, select Area from the Edit menu.

Use the Site Survey Area List dialog box to browse the list and descriptions of the survey areas.
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To edit the properties of an existing site survey area, select an area name and click Edit Area.

Use the Site Survey Area dialog box to add new tests and survey area descriptions as needed.

The Test Name field lists the tests defined for that area. To add a new test, click the ellipsis (…) 
button. For more information on adding new tests, refer to Setting New Test Parameters on page 35.

To save the changes to the site survey workspace, click OK.

To remove the area from the current site survey workspace, click Delete.

Delete is disabled when defining a survey area.

3.3.10 Editing the Default Settings Property Pages

To edit the default properties of the Setup, Meter Settings, Sounds and Logging property pages, 
select Default Settings from the Edit menu.

Use the Setup, Meter Settings, Sounds and Logging property pages to change the default settings 
for the current site survey workspace, as described in the following sections.

Setup Property Page

To configure the site survey workspace, click the Setup tab on the Site Survey Settings dialog 
box.
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If a pre-4.0 version of Microsoft Internet Explorer† is running on a Microsoft Windows† 95 (Rev 
B) system, the Setup property page does not display. Update Internet Explorer to version 4.0 or 
later to resolve this problem.

Use the Setup property page to: 

• Enter the surveyor name.

• Enable or disable automatic rerun.

• Enter the Internet Control Message Protocol (ICMP) host address.

• Set the number of pings per ICMP test.

• Set the number of ICMP tests.

• Set the packet size for each ICMP test.

• Set the time allowed for each ICMP test.

• Specify a single ICMP address for all tests.

Surveyor

Enter the surveyor name in the Surveyor field to automatically update the New Site Survey dialog 
box. To save the updated surveyor name in the registry for subsequent surveys, click OK.

Auto Rerun

Run the Site Survey utility in either automatic or manual mode. To run the test suite for the rerun 
count or until the surveyor stops the tests, check Auto Rerun.

ICMP Host Address

Enter an ICMP Host Address in the field provided. The default address is the default address of the 
access point.

Ping Count

Enter the number of pings to be transmitted during the ping test in the Ping Count field. The 
default Ping Count is 100, with a maximum of 2000.

Rerun Count.

Enter the number of times the ping test is transmitted in the Rerun Count field. The default Rerun 
Count is 100. The rerun can be Continuous.

Packet Size

Enter the packet size transmitted during the ping test in the Packet Size field. The default Packet 
Size is 128 bytes, with a maximum of 1472 bytes.

Threshold

Enter the maximum acceptable time to send out and receive the total number of pings for each test 
in the Threshold field. Choose a Threshold time from 1 millisecond to 100,000 milliseconds. 
The default Threshold time for 100 pings is 3500 milliseconds.

Override All Test ICMP Host Addresses

Check this box to use the ICMP host address entered on this page for all tests. Checking this box 
does not replace the host address saved for each test.
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Meter Settings Property Page

To set bounds (thresholds) for the signal quality gradient bars, click the Meter Settings tab on the 
Site Survey Settings dialog box.

Use the Meter Settings property page to:

• Set the round trip time (RTT) thresholds in milliseconds in the Round Trip Bounds field.

• Set the missed beacons percentage thresholds in the Missed Beacon Bounds field.

• Set the transmission retries percentage thresholds in the Transmit Retry Bounds field. 

The RTT Avg, Missed % and Retry % indicators on the Site Survey Test dialog box display:

• Green if the average of the previous tests is below the lower threshold.

• Red if the average of the previous tests is above the upper threshold.

• Yellow if the average of the previous tests is between the upper and lower thresholds.

If, for example, the subsequent round trip times average 20 milliseconds, the percentages of missed 
beacon average 20% and the percentages of transmission retries average 40%, the RTT Avg 
indicator is green (below the lower bounds), the Missed % indicator is yellow (between the upper 
and lower bounds) and the Retry % is red (above the upper bounds).
24 Intel® PRO/Wireless 2011B LAN Site Survey Administrators Guide



Chapter 3. Using the Site Survey Utility
Sounds Property Page

To enable or disable audible alarms, click the Sounds tab on the Site Survey Settings property 
page.

Use the Sounds property page to:

• Disable or enable a timeout alarm.

• Disable or enable a roaming alarm.

• Disable or enable a threshold alarm.

• Disable or enable a test completion alarm.

All four alarm sounds are enabled by default.

To set the volume level or the specific sound assigned to each alarm, use the standard Microsoft 
Windows† Volume and Sounds or Sounds and Multimedia control panels.

Play on Timeout

To disable an audible alarm every time a ping test timeout is reached, uncheck Play on Timeout.

To enable an audible alarm every time a ping test timeout is reached, check Play on Timeout.

Play on Roam

To disable an audible alarm every time a computer roams between access points, uncheck Play on 
Roam.

 To enable an audible alarm every time a computer roams between access points, check Play on 
Roam.

Play on Threshold

To disable an audible alarm every time the threshold time is met or exceeded, uncheck Play on 
Threshold.

To enable an audible alarm every time the threshold time is met or exceeded, check Play on 
Threshold.

Play on Test Complete

To disable an audible alarm every time a suite of ping tests has been transmitted, uncheck Play on 
Test Complete.
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To enable an audible alarm every time a suite of ping tests has been transmitted, check Play on Test 
Complete.

Logging Property Page

To enable or disable logging, click the Logging tab on the Site Survey Settings property page.

Use the Logging property page to:

• Enable or disable logging.

• Enable or disable automatic log file clearing before each test.

• Enable or disable a warning before a log is cleared.

All three logging options are enabled by default.

It is important to enable logging in order to record test results and notes in the Site Survey Report 
document. If unchecked, no logging takes place during the ping tests.

The log file records the date, time, area name, test name, packet size, rerun count, signal quality 
boundaries, any system messages or notes and, if enabled, real-time test noise data or data points.

Enable Logging

To keep a record of test results, check Enable Logging.

To disable logging, uncheck Enable Logging.

Clear Log Contents Before Each Test

To preserve the results of previous tests, uncheck Clear Log contents before each test,

To  clear the contents of the log before a test suite is run, check Clear Log contents before each 
test.

Confirm Before Log Contents Are Cleared

To automatically clear the log file, uncheck Confirm before log contents are cleared.

To warn the surveyor before clearing the log file, check Confirm before log contents are cleared.
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3.3.11 Viewing Site Survey Area Information

To display the Site Survey Area List dialog box, select Areas from the View menu.

Use the Site Survey Area List dialog box to display a list and description of survey areas.

To display the Site Survey Area dialog box, select an area name and click Edit Area.

Add new tests and survey area descriptions as needed.
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3.3.12 Viewing Access Point Information

To display the recognized access points in range of the target computer, select Known APs from the 
View menu.

Use the Known Access Points dialog box to:

• View the access point Basic Service Set Identifier (BSSID).

• View the number of associated computers.

• View the computer (MU) type and status.

• View the data rate.

An icon next to each access point indicates whether the access point is mandatory or preferred, and 
whether or not the access point is associated.

A list of access points within range of the computer is also shown.

To change the access point type to Mandatory or Roaming, right click an access point.

Rates is disabled in direct sequence spread spectrum systems.
28 Intel® PRO/Wireless 2011B LAN Site Survey Administrators Guide



Chapter 3. Using the Site Survey Utility
3.3.13 Viewing Computer Noise Information

To view computer (MU) noise information, select Noise Meter from the View menu.

The Noise Meter dialog box  displays a graph of the Average Signal Level.

The average signal level ranges from  0 to 31 and is calculated as the mean of the maximum and 
minimum signal values over time.

The Noise Meter dialog box  displays the Minimum, Maximum and Average signal level values to 
the right of the graph and continuously updates both.

To reset the graph to zero, click Reset.

Stop changes to Go.

To begin a new display as signal level values are received, click Go.

To append channel quality values to the logfile, check Record Real Time Data.

3.3.14 Viewing Computer Signal Quality Information

To view computer (MU) signal quality information, select Signal Quality from the View menu.
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Use the Signal Quality dialog box to:

• Display the strength of the radio signal transmitted by an access point.

• Display the real-time percentage of missed beacons.

• Display the percentage of transmission retries.

• Display the percentage of CRC errors

This information is useful in determining if the trial site survey access point placement locations are 
effective for providing radio coverage to the proposed radio coverage area.

3.3.15 Generating the Site Survey Report

For each site survey workspace, you can generate an Intel® PRO/Wireless 2011B LAN Site Survey 
Report that contains:

• An overview of the survey.

• Installation considerations.

• Survey findings.

• Equipment placement recommendations.

• A detailed results section.

The report is a Microsoft WordPad† Rich Text Format (RTF)  document that can be generated when 
the survey is complete.

To edit or print the report, select Cut, Copy, or Paste from the Edit menu or Print from the File 
menu, as appropriate.

The template for a new report has the filename “Site Survey Results.doc” and is installed in 
the same directory as the Site Survey utility program.

3.3.16  Creating a New Survey Area

To display a Site Survey Area dialog box, select New from the Area menu.

Use the Site Survey Area dialog box to:

• Enter an area name.

• Enter a description.

This area should correspond to a location where the surveyor is testing for radio transmission 
strength in relation to an intended Intel® PRO/Wireless 2011B LAN component installation.
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If a workspace is already open, you are prompted to save the existing workspace. To add the area to 
the workspace, click OK.

3.3.17 Selecting and Editing an Existing Survey Area

To display the Site Survey Area List dialog box, click Select from the Area menu.

Use the Site Survey Area List dialog box to display a list and description of survey areas.

To display the Site Survey Area dialog box, select an area and click Edit Area.

Add new tests and survey area descriptions as needed.

To save the changes to the site survey workspace, click OK. 

To remove the area from the current site survey workspace, click Delete.

3.3.18 Clearing the Text File Log for an Open Survey Area

To delete the log contents for the active survey workspace, select Clear Log Contents from the 
Area menu.

3.3.19 Editing the Note File for an Open Survey Area

To display the Note Editing dialog box, select Edit Note from the Area menu.

Use the Edit Note dialog box to add notes to the log file of the active survey workspace.
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3.3.20 Running ICMP Tests

To display the Site Survey Test dialog box, select Run ICMP Test from the Area menu.

Use the Site Survey Test dialog box to:

• View and select associated access points.

• Define a new survey area.

• View, select or define tests defined for the workspace.

• View the test statistics.

• View or clear the test results.

• Start, pause or stop a test.

• View the accumulated test result totals.

Internet Control Message Protocol (ICMP) tests are “ping” tests assessing radio transmission 
roundtrip, delay time and transmission signal strength.

To begin the ICMP test, click Start Test.

When the test begins, Start Test changes to Stop.

To stop the ICMP test, click Stop.
32 Intel® PRO/Wireless 2011B LAN Site Survey Administrators Guide



Chapter 3. Using the Site Survey Utility
Setting  ICMP Test Parameters

Use the Site Survey Test dialog box to set the following ICMP test parameters.

Access Point

To select a different access point from the available access points list, click the ellipsis (…) button.

Area

To define a new survey area, select (New) from the Area list and click the ellipsis (…) button.

Test

To display the tests defined for the workspace, select Test from the Area list.

To enter new test settings or edit existing test settings, click the ellipsis (…) button.

Test Statistics

The Test Statistics area displays:

• The total round trip ping time in milliseconds.

• The tests remaining in the run.

• The elapsed test time in seconds.

• The number of test runs remaining.

• The number of retries.

• The average transmit data rate.

• The number of packets transmitted in megabits per second (Mbps).

• The number of packets transmitted and received at each data rate: 1, 2, 5.5 and 11 Mbps.

• The total number of packets transmitted and received.

The number of packets transmitted is often one or two packets more than the number indicated in 
the Test definition. Address Resolution Protocol (ARP) packets transmitted with the test packets 
are counted and comprise the extra packets.

Results List

The Results List displays:

• The ping count.

• The number of errors

• The cumulative number of retries.

• The round trip time (RTT).

• The percentage of missed beacons.

The list holds 1,000 pings, but can only display ten at a time. To browse through the entire list, click 
the scroll bar control. 

Clear List

To clear the contents of the results list, click Clear List.
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Progress Bar Graphs

The gradient progress bar graphs arrayed at the bottom of the Site Survey Test dialog box display:

• The average round trip time (RTT Avg) achieved during the test.

• The percentage of missed beacons (Missed %) achieved during the test.

• The percentage of retried packets (Retry %) achieved during the test.

• The percentage of the threshold that the sum of the round trip times approach.

• The average signal level achieved during the test.

The numerical values are displayed in white in the middle of each progress bar.

The bars change color as the values approach the lower and upper bounds.

• Green indicates a value below the lower bound.

• Yellow indicates a value between the bounds.

• Red indicates a value greater than the upper bound.

For information on setting bounds (thresholds) for the graphs, refer to Meter Settings Property Page 
on page 24.

For information on setting the threshold time, refer to Setup Property Page on page 22 and  Setting 
New Test Parameters on page 35.

Start Test

To begin the ICMP test, click Start Test.

When the test begins, Start Test changes to Stop.

To stop the ICMP test, click Stop.

Edit Note

To display a dialog box for entering test notes, click Edit Note. Test notes are added to the log file.

Test Totals

To display the Site Survey Totals dialog box, click Test Totals.
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Use the Site Survey Totals dialog box to:

• Display the time the tests were started and stopped.

• Display the number of tests run.

• Display the number of reruns.

• Display the total roundtrip time.

• Display the average roundtrip time.

• Display the total number of timeouts.

• Display the test completion status.

Packet throughput information is summarized as the number of packets sent and received and the 
data rates for each. If logging is enabled, these values are recorded in the log file.

Setting New Test Parameters

To set new test parameters, select (New) from the Test list in the Site Survey Test dialog box and 
click the ellipsis (…) button.

Use the New Test Settings dialog box to:

• Enter a test name.

• Define test packet sizes.

• Select a test ping count.

• Enable or disable the test Auto Rerun, Sounds and Logging features.

• Change host address information.

• Display the Settings property pages.

Test Name

Enter the name of the test for the active survey area in the Test Name field.

Host Address

The default ICMP host address is the default address of the access point. To change it for a new test, 
enter a new address in the Host Address field. 
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Rerun Count

Enter the number of times the ping test is transmitted in the Rerun Count field. The default Rerun 
Count is 100. The rerun can be Continuous.

Ping Count

Enter the number of pings to be transmitted during the ping test in the Ping Count field. The 
default Ping Count is 100, with a maximum of 2000.

Packet Size

Enter the packet size transmitted during the ping test in the Packet Size field. The default Packet 
Size is 128 bytes, with a maximum of 1472 bytes.

It is important not to change test parameters such as packet size between individual test runs  during 

a test. A Socket Error may result. If you need to use different packet sizes, select a new test.

Threshold

Enter the maximum acceptable time to send out and receive the total number of pings for each test 
in the Threshold field. Choose a Threshold time from 1 millisecond to 100,000 milliseconds. 
The default Threshold time for 100 pings is 3500 milliseconds.

Auto Rerun

Run the new test suite in either automatic or manual mode. If Auto Rerun is checked, the test suite 
runs for the rerun count or until the surveyor stops the tests.

Enable Sounds

To enable audible alarms, check Enable Sounds.

To disable audible alarms, check Enable Sounds.

Enable Logging

To keep a record of test results, check Enable Logging.

To disable logging, uncheck Enable Logging.

Advanced

To open the Advanced Test Settings property pages (Meter Settings, Sounds and Logging)  and 
change the default settings for the active survey area workspace, click Advanced.

For information on meter settings, refer to Meter Settings Property Page on page 24.

For information on sound settings, refer to Sounds Property Page on page 25.

For information on logging settings, refer to Logging Property Page on page 26.
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3.3.21 Running FTP Throughput Tests

To perform File Transfer Protocol (FTP) droughtier tests, select Run Throughput Tests from the 
Area menu.

Use the FTP Test dialog box to:

• Set the FTP site name or IP address.

• Enable of disable anonymous login.

• Set an account login name and password (if anonymous login is disabled).

• Specify whether the file is are to be transferred to or from the FTP site.

• Set the name of the file to be transferred to or from the FTP site.

• Set a default subdirectory to which the file is transferred on the FTP site.

• Set the number of times the file is transferred.

• Enable of disable test result logging.

• Include or exclude excessive transmission times from the calculated average.

• View the test results.

Make sure that a separate host or PC workstation is connected to the wired LAN side of the access 
point to perform File Transfer Protocol (FTP) throughput tests. The FTP server should be on the 
same wired LAN segment or subnet as the access point to ensure that wired network characteristics 
do not adversely affect test results.

Click Start to begin the throughput test.
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Setting FTP Throughput Test Parameters

Use the FTP Test dialog box to set the following FTP throughput test parameters.

FTP Site Name

Enter the IP address or site name of the FTP site in the FTP Site Name field.

Anonymous Login

To disable login without a username or password, uncheck  Anonymous Login.

To enable login without a username or password, check  Anonymous Login.

User Name

When Anonymous Login is disables, enter the account login name (user name) for the FTP site.

User Password

When Anonymous Login is disabled, enter the login  password for the FTP site.

Get File from Site

To test download times by transferring the file from the FTP site, select the Get file from Site 
option.

Put File to Site

To test upload times by transferring the file to the FTP site, select the Put file to Site option.

The Get file from Site and the Put file to Site options are mutually exclusive.

Log Results

To record the test results in the log file,  check Log Results.

To disable logging,  uncheck Log Results.

Get/Put Filename

Enter the path and filename of the FTP file to be transferred.

When Put file to Site is selected, the ellipsis (…) button is enabled. To navigate to a local test file, 
click the ellipsis button.

Default Site Directory

When Get file from Site is selected, you may specify a subdirectory on the FTP server to which the 
file is transferred. Enter it in the Default Site Directory field.

FTP Run Count

Enter the number of times to transfer the FTP file in the FTP run count field.

Omit Lows/Highs from Transfer Average

To exclude transmit times lower or higher than the current shortest or longest transmit time from 
the transfer Rate Average calculation, check Omit Lows/Highs from Transfer Average.
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To include transmit times lower or higher than the current shortest or longest transmit time from the 
transfer Rate Average calculation, uncheck Omit Lows/Highs from Transfer Average.

Start

To begin the FTP throughput test, click Start.

Once the test begins, Start changes to Stop.

To stop the FTP throughput test, click Stop.

Test Results

Use the Test Results area of the FTP Test dialog box to:

• View the number of operations performed.

• View the total number of bytes transferred.

• View the average transfer rate, in kilobytes per second and bytes per second.

• View the highest transfer rate, in bytes per second.

• View the lowest transfer rate, in bytes per second.
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Site surveys differ depending on the size of the survey site.

Smaller sites are surveyed for one or two access points to provide coverage over a space no larger 
than a single room.

Medium sites could require between 10 and 20 access points for the size of a warehouse or several 
rooms.

Large sites could require between 20 and 100 access points for a large building with different radio 
coverage service areas in different parts of the building.

Discuss any special installation requirements. Determine the types of cables to be connected to the 
access points (Category 5 for 10 Base T 10 Mbps Ethernet or 10/100 switched Ethernet, fiber optic 
cabling, etc.)

4.1 Conducting a Survey for a Small Area

To conduct a survey in a site where one or two access points are anticipated:

1. Document the size and layout of coverage area.

Document RF systems already in use, location of host system, and available AC power.

2. Set up an access point in the middle of the room or where it is estimated that the coverage cell 
is the largest.

3. Walk the perimeter of the coverage area and measure radio coverage.

For an 11 Mbit direct sequence network, study round-trip ping times and data rates.

The individual round-trip ping time is usually about 7 ms before the rate changes from 11 
Mbits to 5.5 Mbits, using a packet size of 1024 bytes.

To display the number of packets transmitted and received and the rates for each, click Test 
Totals on the Site Survey Tests dialog box. See 3.3.20 Running ICMP Tests on page 32 for 
more information.

Move the mobile computer in different directions. Position the computer between the surveyor 
and the access point. Do not walk fast or coverage area dead spots could be missed.

Depending on the coverage requirements, the perimeter for each of the data rates might have to 
be determined separately. Total test time should be less than 13 seconds for 1 Mbit or 12 
seconds for 2 Mbit.

4. Mark the location of access points on the blueprint, move the access point to the second survey 
location and repeat the procedure.

Infrastructure backbone, hubs and patch panels should all be documented. Document the 
conditions existing in the final installation.

5. Complete the Site Survey Report.

The report indicates the number and location of the access points. Assign the access points the 
same channel for each coverage area.
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4.2 Conducting a Survey for a Medium or Large Area

To conduct a survey in a site where 10 or more access points are anticipated:

1. Document the size and layout of the coverage area.

Document RF systems already in use, location of host systems, available AC power, possible 
antenna locations, interfering metal fire breaks and wall structures, doorways and passages that 
could help RF propagation, and amount of stock in coverage areas. For a warehouse, document 
how high the stock is kept and how high the lifts go so that the lifts do not damage the access 
points.

2. Set up an access point at one side of the proposed coverage area.

3. Walk the perimeter and measure radio coverage.

If there are multiple floors, measure each floor separately. For an 11 Mbit direct sequence 
network, document round-trip times and data rates. The individual round-trip ping time is 
usually about 7 ms before the rate changes from 11 Mbits to 5.5 Mbits (using a packet size of 
1024 bytes). Move the mobile computer in different directions. Position the computer between 
the surveyor and the access point. Do not walk fast or a radio coverage dead spot might be 
missed.

4. Document the boundary of each coverage area. The data rates could be different in each area.

To result in better coverage, the access point may only need to be moved a meter (three feet) or 
so. For 11 Mbit high data rate networks, reflection is more of a problem. Ceiling sprinklers can 
cause a problem if the access point antenna is less than 60 centimeters (two feet) away. Total 
test time should be less than 13 seconds for 1 Mbit or 12 seconds for 2 Mbit.

For large surveys, consider the site survey boundary areas for multiple buildings. Determine 
whether the network requires a LAN bridge, wireless access points or both.

5. Mark the location of each access point on the blueprint and move the access point to different 
trial location.

Continue the process until the entire site has radio coverage.

6. Take a picture of at least one access point location for each coverage area.

If each coverage area has unique features, take a picture of racks, stock level and hub locations. 
The pictures go into the report and help establish the condition of the site as it was surveyed.

7. Consult with customer technical personnel and document any additional hubs that could be 
required. Fourteen or more access points could require multiple hubs.

Consider exact conditions that exist in the final installation.

8. Complete the Site Survey Report.

The report indicates the number and location of the access points. Assign the access points the 
same channel for each coverage area.
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5.1 Intel Automated Customer Support

You can reach Intel automated support services 24 hours a day, every day at no charge. The services 
contain the most up-to-date information about Intel products. You can access installation 
instructions, troubleshooting information, and product information.

5.1.1 User Guide on Your Product CD-ROM

For more information about installing drivers or troubleshooting other topics, see the online User 
Guide. To view the guide, insert the Intel CD in your drive and wait for the Autorun to display. 
Click the User Guide button to view the guide. Note that a web browser is required to view the 
guide.

5.1.2 Web and Internet Sites

• Support: http://support.intel.com

• Network Products: http://www.intel.com/network

• Corporate: http://www.intel.com

• Newsgroups: news://cs.intel.com

• FTP Host: ftp://download.intel.com

• FTP Directory: /support/network/<device>/

5.1.3 Customer Support Technicians

U.S. and Canada

If you are using this product in conjunction with Intel® PRO/Wireless 2011B LAN hardware in a 
business or office environment and want customer support, please call +1 916-377-7000 (7:00 – 
17:00 M–F Pacific Time). You can also visit the Intel customer support web site
(http://support.intel.com).

Worldwide Access

Intel has technical support centers worldwide. Many of the centers are staffed by technicians who 
speak the local languages. For a list of all Intel support centers, the telephone numbers, and the 
times they are open, refer to the Customer Support Phone Numbers web site
(http://www.intel.com/support/9089.htm).
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5.2 Intel Software License Agreement

IMPORTANT - READ CAREFULLY BEFORE COPYING, INSTALLING OR USING.

Do not use or load this software and any associated materials (collectively, the “Software”) 
until you have carefully read the following terms and conditions. By loading or using the 
Software, you agree to the terms of this Agreement. If you do not wish to so agree, do not 
install or use the Software.

LICENSES

• If you are a network administrator, the “Site License” below shall apply to you.

• If you are an end user, the “Single User License” shall apply to you.

Site License

You may copy the Software onto your organiation’s computers for your organization’s  use, and you 
may make a reasonable number of back-up copies of the Software, subject to these conditions:

1. This Software is licensed for use only in conjunction with Intel component products. Use 
of the Software with non-Intel component products is not licensed hereunder.

2. You may not copy, modify, rent, sell, distribute or transfer any part of the Software except as 
provided in this Agreement, and you agree to prevent unauthorized copying of the Software.

3. You may not reverse engineer, decompile, or disassemble the Software.

4. You may not sublicense or permit simultaneous use of the Software by more than one user.

5. The Software may include portions offered on terms in addition to those set out here, as set out 
in a license accompanying those portions.

Single User License 

You may copy the Software onto a single computer for your personal, noncommercial use, and you 
may make one back-up copy of the Software, subject to these conditions:

1. This Software is licensed for use only in conjunction with Intel component products. Use 
of the Software with non-Intel component products is not licensed hereunder.

2. You may not copy, modify, rent, sell, distribute or transfer any part of the Software except as 
provided in this Agreement, and you agree to prevent unauthorized copying of the Software.

3. You may not reverse engineer, decompile, or disassemble the Software.

4. You may not sublicense or permit simultaneous use of the Software by more than one user.

5. The Software may include portions offered on terms in addition to those set out here, as set out 
in a license accompanying those portions.
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OWNERSHIP OF SOFTWARE AND COPYRIGHTS

Title to all copies of the Software remains with Intel or its suppliers. The Software is copyrighted 
and protected by the laws of the United States and other countries, and international treaty 
provisions. You may not remove any copyright notices from the Software. Intel may make changes 
to the Software, or to items referenced therein, at any time without notice, but is not obligated to 
support or update the Software. Except as otherwise expressly provided, Intel grants no express or 
implied right under Intel patents, copyrights, trademarks, or other intellectual property rights. You 
may transfer the Software only if the recipient agrees to be fully bound by these terms and if you 
retain no copies of the Software.

LIMITED MEDIA WARRANTY

If the Software has been delivered by Intel on physical media, Intel warrants the media to be free 
from material physical defects for a period of ninety days after delivery by Intel. If such a defect is 
found, return the media to Intel for replacement or alternate delivery of the Software as Intel may 
select.

EXCLUSION OF OTHER WARRANTIES

EXCEPT AS PROVIDED ABOVE, THE SOFTWARE IS PROVIDED “AS IS” WITHOUT 
ANY EXPRESS OR IMPLIED WARRANTY OF ANY KIND INCLUDING WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT, OR FITNESS FOR A PARTICULAR 
PURPOSE. Intel does not warrant or assume responsibility for the accuracy or completeness of 
any information, text, graphics, links or other items contained within the Software.

LIMITATION OF LIABILITY

IN NO EVENT SHALL INTEL OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES 
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, LOST PROFITS, BUSINESS 
INTERRUPTION, OR LOST INFORMATION) ARISING OUT OF THE USE OF OR 
INABILITY TO USE THE SOFTWARE, EVEN IF INTEL HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS PROHIBIT EXCLUSION 
OR LIMITATION OF LIABILITY FOR IMPLIED WARRANTIES OR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY 
NOT APPLY TO YOU. YOU MAY ALSO HAVE OTHER LEGAL RIGHTS THAT VARY 
FROM JURISDICTION TO JURISDICTION.

TERMINATION OF THIS AGREEMENT

Intel may terminate this Agreement at any time if you violate its terms. Upon termination, you will 
immediately destroy the Software or return all copies of the Software to Intel.

APPLICABLE LAWS

Claims arising under this Agreement shall be governed by the laws of California, excluding its 
principles of conflict of laws and the United Nations Convention on Contracts for the Sale of 
Goods. You may not export the Software in violation of applicable export laws and regulations. 
Intel is not obligated under any other agreements unless they are in writing and signed by an 
authorized representative of Intel.

GOVERNMENT RESTRICTED RIGHTS

The Software is provided with “RESTRICTED RIGHTS.” Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in FAR52.227-14 and DFAR252.227-7013 et seq. 
or its successor. Use of the Software by the Government constitutes acknowledgment of Intel’s 
proprietary rights therein. Contractor or Manufacturer is Intel Corporation, 2200 Mission College 
Blvd., Santa Clara, CA 95052.
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5.3 Limited Hardware Warranty

Intel warrants to the original owner that the hardware product delivered in this package will be free 
from defects in material and workmanship. This warranty does not cover the product if it is 
damaged in the process of being installed. Intel recommends that you have the company from 
whom you purchased this product install the product. Intel reserves the right to fill your order with 
a product containing new or remanufactured components.

THE ABOVE WARRANTY IS IN LIEU OF ANY OTHER WARRANTY, WHETHER 
EXPRESS, IMPLIED OR STATUTORY, INCLUDING BUT NOT LIMITED TO ANY 
WARRANTY OF NON-INFRINGEMENT OF INTELLECTUAL PROPERTY, 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR ARISING OUT 
OF ANY PROPOSAL, SPECIFICATION OR SAMPLE.

This warranty does not cover replacement of hardware products damaged by abuse, accident, 
misuse, neglect, alteration, repair, disaster, improper installation or improper testing.

If the hardware product is found to be otherwise defective, Intel, at its option, will replace or repair 
the hardware product at no charge except as set forth below, provided that you deliver the hardware 
product along with a Return Material Authorization (RMA) number (see below) either to the 
company from whom you purchased it or to Intel (North America only). If you ship the hardware 
product, you must assume the risk of damage or loss in transit. You must use the original container 
(or the equivalent) and pay the shipping charge.

Intel may replace or repair the hardware product with either new or remanufactured product or 
parts, and the returned hardware product becomes Intel’s property.  Repaired or replaced products 
will be returned at the same revision level as received or higher, at Intel's option. Intel reserves the 
right to replace discontinued product with an equivalent current generation product.

This warranty gives you specific legal rights and you may have other rights which vary from state to 
state. All parts or components contained in this hardware product are covered by Intel’s limited 
warranty for this product; the product may contain fully tested, recycled parts, warranted as if new. 
For warranty information call one of the numbers below.

5.3.1 Returning a Defective Product

From North America

Before returning any hardware product, contact Intel Customer Support to obtain an RMA number 
by calling +1 916-377-7000.

If the Customer Support Group verifies that the hardware product is defective, they will have the 
Return Material Authorization Department issue you an RMA number to place on the outer 
package of the hardware product. Intel cannot accept any product without an RMA number on the 
package.

All Other Locations

Return the hardware product to the place of purchase for a refund or replacement.
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5.3.2 Limitation of Liability and Remedies

INTEL’S SOLE LIABILITY HEREUNDER SHALL BE LIMITED TO DIRECT, 
OBJECTIVELY MEASURABLE DAMAGES. IN NO EVENT SHALL INTEL HAVE ANY 
LIABILITY FOR ANY INDIRECT OR SPECULATIVE DAMAGES (INCLUDING, 
WITHOUT LIMITING THE FOREGOING, CONSEQUENTIAL, INCIDENTAL, AND 
SPECIAL DAMAGES) INCLUDING, BUT NOT LIMITED TO, INFRINGEMENT OF 
INTELLECTUAL PROPERTY, REPROCUREMENT COSTS, LOSS OF USE, BUSINESS 
INTERRUPTIONS, LOSS OF GOODWILL, AND LOSS OF PROFITS, WHETHER ANY 
SUCH DAMAGES ARISE OUT OF CONTRACT, NEGLIGENCE, TORT OR UNDER ANY 
WARRANTY, IRRESPECTIVE OF WHETHER INTEL HAS ADVANCE NOTICE OF 
THE POSSIBILITY OF ANY SUCH DAMAGES. NOTWITHSTANDING THE 
FOREGOING, INTEL’S TOTAL LIABILTIY FOR ALL CLAIMS UNDER THIS 
AGREEMENT SHALL NOT EXCEED THE PRICE PAID FOR THE PRODUCT. THESE 
LIMITATIONS ON POTENIAL LIABLITIES WERE AN ESSENTIAL ELEMENT IN 
SETTING THE PRODUCT PRICE. INTEL NEITHER ASSUMES NOR AUTHORIZES 
ANYONE TO ASSUME FOR IT ANY OTHER LIABILITIES.

Some states do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations may not apply to you.

Critical Control Applications

Intel specifically disclaims liability for use of the hardware product in critical control applications 
(including, for example only, safety or health care control systems, nuclear energy control systems, 
or air or ground traffic control systems) by you or your customers, and such use is entirely at the 
user’s risk. You agree to defend, indemnify, and hold Intel harmless from and against any and all 
claims arising out of use of the hardware product in such applications by you or your customers.

Software

Software provided with the hardware product is not covered under the hardware warranty described 
above. See the applicable software license agreement which shipped with the hardware product for 
details on any software warranty.
Intel® PRO/Wireless 2011B LAN Site Survey Administrators Guide 47



Chapter 5. Customer Support
5.4 Product Registration

The Beginning of a Valuable Relationship…

Register Your Product Today!

As a registered customer, you stay connected and informed by receiving:

• Access to Intel’s outstanding technical support for optimum performance.

• Advance notice of product upgrades and new products to give you a competitive edge.

• Information updates to keep you current.

• Special offers for savings on products and evaluation units.

There are three easy ways to register:

• Browse the Intel product registration web site (http://www.intel.com/product/register).

• Mail the attached postage prepaid registration card.

• Fax the attached registration card to +1 608-757-1727.
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For U.S. and international  regulatory compliance information for the Intel® PRO/Wireless 2011B 
LAN, please see the Regulatory Specifications posted at the Intel customer support web site
(http://support.intel.com).

Important Regulatory Compliance Instructions

If your country is listed on the regulatory labels included with the Intel® PRO/Wireless 2011B 
LAN hardware, remove the label for your country and attach it to the bottom of the device in the 
space provided. Failure to apply the label for the appropriate country constitutes a breach of law.

A minimum separation distance of 20 cm (8 inches) should be maintained between the radiating 

element of this product and nearby persons to comply with Federal Communications Commission 

(FCC) rules for Radio Frequency (RF) exposure.
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interference considerations, 10
signal strength, 15

antenna, 11
antenna options, 1, 5, 7, 9, 11, 15, 17
AP placement, 11
directional, 12
direct-sequence, 10
omnidirectional, 11
placement, 10
signal loss, 10
signal strength, 15

Area menu
edit area, 31
FTP Test, 37
ICMP Test, 32
logfile, 31
name and description, 30
notes, 31
text file, 31

C
creating a workspace

new area, 30
Site Survey dialog box, 19

D
direct-sequence

antennas, 10
channel, 10
interference, 10

E
Edit menu

area, 22
default settings, 22
Logging property page, 26
Meter Settings property page, 24
Setup property page, 23
Sounds property page, 25

editing
default settings, 22
existing survey area, 31
FTP test parameters, 38

ICMP test parameters, 33
information, 21
Logging property page, 26
Meter Settings property page, 24
note file, 31
properties, 21
property pages, 22
report, 30
Setup property page, 23
Sounds property page, 25

electrical considerations
AP power, 13
ground circuit, 12
hard wired devices, 13
surge suppressor, 12
UPS, 12
wall outlets, 12

existing survey area
area list, 31
note file, 31
remove, 22
report, 30
tests, 31

F
File menu

existing site survey, 19
import, 20
new area, 19
new site survey, 19
reports, 20

H
hardware installation

antenna, 11
antenna coverage, 11
dual antenna assembly, 11

I
ICMP test

area, 33
edit note, 34
parameters, 33
progress bars, 34
results, 33
statistics, 33
threshold, 34
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areas and tests, 20

installing utility
CDROM, 16

L
Logging property page

clear log, 26
logfile, 26
logging, 26

M
Meter Settings property page

bounds, 24
threshold, 24

mobile unit (MU)
coverage considerations, 10
direct-sequence, 10
noise meter, 29
signal quality, 29

N
new site survey

area, 19
importing, 20
report, 20

note file
entering notes, 34
open survey area, 31

P
Power Injector, 4, 13

R
regulatory compliance, 49

S
Setup property page

default ICMP address, 23, 35
ICMP host address, 23
packet size, 23, 36
ping, 23, 36
rerun, 23, 36
surveyor, 23
Threshold, 23, 36

signal quality
antenna placement, 11
AP, 30
AP info, 28
coverage considerations, 10
ICMP Test, 32

interference considerations, 10
meter settings, 24
MU, 29
site survey results, 30
throughput tests, 37

Site Survey
antenna placement, 11
considerations, 9
coverage considerations, 10
electrical considerations, 12
installation, 16
Intel PRO/11 wireless LAN, 9
interference considerations, 10
preparation, 9
site survey inspection, 9
starting, 18
trial installation areas, 9
utility, 15

site survey
antenna coverage, 11

Site Survey report
considerations, 30
findings, 30
generation, 20
placement recommendations, 30

Site Survey Utility
installation, 16
starting, 18

Sounds property page
ping, 25, 26
roam, 25
threshold time, 25
timeout, 25

survey area inspection
electrical, 12
requirements, 9
variables, 10

T
test parameters

anonymous login, 38
area, 33
new, 35
password, 38
setting FTP, 38
setting ICMP, 33
site name, 38
user name, 38

tests
FTP, 37
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FTP parameters, 38
ICMP, 32
progress bars, 34

throughput tests
anonymous login, 38
FTP run count, 38
FTP site name, 38
parameters, 38
password, 38
results, 39
subdirectory, 38
username, 38

transmission rate
AP, 28
MU, 28

V
View menu

access point info, 28
area info, 27
signal quality, 30

viewing
MU signal quality, 29
noise meter, 29

W
Welcome dialog box

existing site survey, 18
new workspace, 18

workspace template, 18
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